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An Imaging Roadmap for Biology Education: From Nanoparticles to 

Whole Organisms 
 

Biological imaging illustrates the importance of the relationship between biological scale and imaging scale, offers new 

insights into biological structure and function, brings quantification into biology education, and provides ways of 

advancing nanomedicine, regenerative medicine, and nuclear medicine which contribute to the NIH Roadmap 

initiatives This nanoimaging, molecular imaging, and medical imaging teaching unit was developed for three, one hour 

class periods in an introductory course on ways of knowing biology. 
 

Executive Summary for Teachable Unit  
 

Table of Contents 

 

 

 

I. Title: An Imaging Roadmap for Biology Education: From Nanoparticles to Whole Organisms 

 

II. Developer: Dan Kelley 

 

III. Learning Goals and Outcomes 

 

A. Learning Goals                    

Students will understand the importance of biological scale and imaging scale when producing  

biological images.  

Students will understand how imaging provides scientists and physicians ways of knowing the  

structure and function of biological processes. 

Students will understand that imaging is a quantitative tool in biology, which allows them to  

measure and interpret images across the biological scale.  

Students will understand how nanoimaging, molecular imaging, and medical imaging can advance  

nanomedicine, regenerative medicine, and nuclear medicine and contribute to the goals of 

the NIH Roadmap. 

 

 B. Specific Learning Outcomes 

Students will be able to answer questions about biological images at various biological scales  

which fosters an understanding of the relationship between biological scale and imaging 

scale and fosters the development of analytical skills. 

Students will be able to answer questions about biological images with fluorescent probes or  

radioactive markers which fosters an understanding of the way imaging provides 

information about biological structure and function of biological processes. 

Students will be able to answer survey questions on the informativeness and usefulness of 2D  

images, 3D images, and stereolithographic models which fosters the development of 

evaluation skills.   

Students will be able to demonstrate proficiency using NIH Image J software to quantify biological  

Images and interpret the quantifications which fosters the understanding that biological 

images are quantifiable and fosters the development of skills in computer use, analysis 

and synthesis. 

  Students will be able to know how nanoimages, molecular images and medical images advance  

nanomedicine, regenerative medicine, and nuclear medicine which fosters an 

understanding how imaging contributes to the NIH Roadmap initiatives.  
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IV. Scientific Teaching Themes: 

A. Scientific Teaching 

With evolving imaging technology, biological imaging misconceptions develop:  

(1) Biological science and imaging science are distinct. This is a misconception because these 

sciences are symbiotic.  

(2) Any imaging technique can image any biological specimen. This is a misconception since 

there is a relationship between biological scale and imaging scale.  

(3) Biological images reveal mainly biological structure. This is a misconception since molecular 

imaging with fluorescent probes, PET imaging with radioactive markers, and fMRI reveal 

structure and function of biological processes. 

(4) Biological imagines are not quantifiable. This is a misconception since computer software 

programs like NIH Image J can measure biological images.  

(5) Biological images do not advance science or medicine. This is a misconception since imaging 

can advance nanomedicine, molecular medicine, and nuclear medicine, which contribute to the 

NIH initiatives.  

 

These misconceptions are addressed in our learning goals by showing how biological scale and 

imaging scale are related, how biological imaging provides ways of knowing biological structure 

and function, how biological images can be quantified, and how biological images contribute to the 

NIH Roadmap initiatives.  

 

We use backward design to create this teaching unit. The concepts that are generally considered 

difficult to understand such as biological scale, ways of knowing biology, quantifying images, and 

advancing NIH Roadmap initiatives provide a basis for the learning goals.  By transferring learning 

goals from the perspective of the teacher to learning outcomes from the perspective of the student, 

we are able to delineate measurable criteria for assessment purposes. Course activities are 

developed with this in mind. 

 

B. Active Learning 

When introducing a topic we select interesting nanoimages, molecular images, and medical images 

so that students can understand the relationship between biological scale and imaging scale.  By 

introducing fluorescent probes, PET images with radioactive markers, and fMRI, students can gain 

an understanding how images provide ways of knowing biological structure and function.  

Through introduction of image analysis software, NIH Image J, students are able to extend their 

conceptual understanding of imaging analysis into a computer skill using real data. In this way they 

come to understand the concept that biological images can be quantified.  Contributions of 

nanoimaging to nanomedicine, molecular imaging to regenerative medicine, and PET nuclear 

medical imaging to nuclear medicine can advance NIH Roadmap initiatives.  

  

C. Assessment 

Assessments help determine whether or not learning goals and specific learning outcomes have 

been accomplished. Written answers to questions about biological scale using nanoimages, 

molecular images, and medical images help foster an understanding of the relationship between 

biological scale and imaging scale as well as the development of analytical skills.  

 

Written answers to questions about biological structure and function using images with fluorescent 

probes and radioactive markers help determine an understanding of the way imaging provides ways 

of knowing biological function and develops analytical skills.   

 

Answers to survey questions about the quality of visual information and biological utility of 2D 

images, 3D images, and stereolithographic models help develop evaluation skills.  

 

Answers to questions about quantification of images help determine students’ proficiency with NIH 

Image J software. 

 

Pre and post quizzes determine how much knowledge students actually have acquired and how well 

they have developed new skills. The in-class activities are meant to help students build knowledge 

and skills.  

 

D. Diversity 
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Diversity in students’ cultural and educational backgrounds is accounted for by incorporating 

multiple modes of teaching and assessment forms. To minimize discrepancies in education, we 

review background information in our minilectures. We engage students of diverse cultures by 

introducing scientists from different nations who have contributed to imaging. Audiovisual aids 

help clarify difficult material. We use the video, “Power of Ten,” to introduce the concept of 

biological scale and a movie clip of the “Hulk” to illustrate the effect of fluorescence. Using a 

computer software program, NIH Image J, we quantify images and using hand held models of a 

brain and Phineas Gage’s skull we show how images can be utilized to create stereolithographic 

models.  To assess learning gains we use a variety of assessment forms: oral discussion, written 

answers, surveys, and pre and post assessments. 

 

E. Alignment: Schedule of in-class activities that links learning outcomes and activities/assessment 

   

        

Biological Images Activity/Assessment Learning Outcomes 

Nanoimages Video, “Powers of Ten” -Will be able to understand biological 

scale 

 Open Ended Question about 

biological and imaging scales 

-Will be able to understand biological 

scale’s relationship to imaging scale 

 Use NIH Image J to quantify height 

and intensity of  Nanobucky 

-Will understand that images can be 

quantified 

-Will be able to use NIH Image J  

 Minilecture:  

Nanoimages aid nanotechnology to 

create nanodevices which can 

advance nanomedicine 

-Will understand how nanoimages 

can contribute to NIH Roadmap 

initiatives in nanomedicine 

Molecular Images Problem Solving:  

Questions about the fluorescent 

rabbit, Alba 

-Will understand how fluorescence 

incorporates on the systemic-level 

scale 

-Will be able to develop analytical 

skill reading fluorescent probes’ 

wavelength charts 

 Mini-Demonstration: 

Use NIH Image J to quantify 

intensity of DAPI stained nucleus of 

endothelial cell 

-Will understand how fluorescent 

probes incorporate on the cellular-

level scale 

-Will understand that images can 

provide ways of knowing biological 

structure 

-Will be able to use NIH Image J 

 Monitor eGFP human embryonic 

stem cell differentiation  

Use NIH Image J to quantify 

intensity of eGFP stem cells  

-Will understand how images can 

provide ways of knowing biological 

function 

-Will be able to use NIH Image J  

 Minilecture: eGFP human embryonic 

stem cell is involved in tissue re- 

engineering which advances 

regenerative medicine 

-Will understand how fluorescent 

molecular images can contribute to 

NIH Roadmap initiatives in 

regenerative medicine.  

Medical Images Answer Survey:  

Case Study: CT of Phineas Gage 

Skull 

Evaluate 2D image, 3D virtual reality 

image, and stereolithographic model 

of skull for visual information 

- Will understand how images can be 

used to create stereolithographic 

model of Gage’s skull  

- Will be able to develop the skill of 

evaluation 

 Answer Survey: 

MRI of brain  

Evaluate 2D image, 3D virtual reality 

image, and sterolithographic model 

of brain for visual information  

-Will understand how images can be 

used to create stereolithoraphic 

model of brain 

-Will be able to develop the skill of 

evaluation 

 Answer Survey: 

Evaluate any 2D image, 3D virtual 

reality image, and sterolithographic 

-Will be able to develop skills of 

evaluation, analysis, and synthesis  
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model for informativeness and 

usefulness  

 Answer PET Questions using 

PET brain image with radioactive 

marker 

-Will understand how PET images 

provide ways of knowing structure 

and function 

-Will understand how PET images 

with radioactive marker can 

contribute to NIH Roadmap 

initiatives in nuclear medicine 

Web Resources  Introduction to Web Resources -Will understand that the internet has 

imaging resources 

Assessment Forms Assessment Forms: 

Oral Discussion 

Written Questions 

Surveys  

Pre and Post Quizzes  

-Will be able to assess learning gains 

from the Teaching Unit 

 

 

     

V. Teaching Plan  

 

 Topic Activity/Assessment Goals and Learning Outcome 

Pre-Day 1 Assessment Answer Pre-Quiz online Students and instructors 

will be able to assess prior 

knowledge about imaging. 

Day 1                                     Nanoimaging 
 

0-5 Overview 

 
Minilecture 

  

 

Students will understand the major content of 

TU, the learning goals, the learning outcomes, 

and how images contribute to the NIH Roadmap 

initiatives  

Elicit/Engage Ask students to think about the contents of the TU and what they want to learn from it.  

5-15 Biological Scale Video, “Powers of Ten” Students will understand biological scale from 

nanoscale to systemic-level scale.  

Elicit: Ask students to think about what they already know about biological scale   

15-20  Open Ended Question: 

Biological scale and imaging 

scale 

Students will understand the relationship 

between biological scale and imaging scale.   

Elicit/Engage: Ask students to think about the imaging techniques available at different scales and the biological specimens that 

can be imaged at those scales.  This activity addresses the misconception that biological sciences and imaging sciences are distinct 

and not symbiotic.  

20-35 Nanoimaging  

 
Minilecture   
 

 

Students will understand that the biological scale 

of nanoparticles is related to the imaging scale of 

the electron microscope.  

 

Students will understand that nanoimages 

provides ways of knowing biological structure 

and function in the nanoscale. 

 

Students will understand that nanoimaging and 

nanotechnology can help develop nanodevices, 

which can advance nanomedicine and contribute 

to the NIH Roadmap initiatives.  

35-55 Nanobucky 

 

Activity: Use NIH Image J to 

quantify height and intensity of 

Nanobucky.  

 

Students will understand that nanoimages can be 

quantified using NIH Image J  

 

Students will be able to use NIH Image J  

Engage/Explore/ Evaluate/Extend:  Ask students to work as a group to measure the height and intensity of the electron 

microscopic image of Nanobucky using NIH Image J software. This will address the misconception that images cannot be 

quantified. Ask students to think how nanodevices can advance nanomedicine. To guide them, the teacher will present PowerPoint 

images of nanodevices that are currently being tested.  
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Day 2 

 
                                                Molecular Imaging  

0-15 Fluorescent Probes   

 
Minilecture    
 

 

Students review the answers for the activity in 

Day 1.  

 

Students will understand that the biological scale 

of molecules is related to the imaging scale of 

the light microscope. 

 

Students will understand how fluorescent probes 

in molecular images provide ways of knowing 

biological structure and function of molecular 

particles.  

 

Students will understand how fluorescence is 

incorporated into the systemic scale of the rabbit 

Alba. 

Evaluate/ Elaborate: Review answers for Day 1 Activity. Review biological and imaging scales. To illustrate fluorescence the 

instructor should show a movie clip of  “The Hulk”   

15-20 Fluorescence   

Systemic Scale 

 

  

 

Problem Solving  
Answer questions about the 

fluorescence of the rabbit Alba  

Students will understand eGFP and what makes 

Alba glow green. 

  

Students will be able to develop their analytical 

skill by reading wavelength and color charts of 

fluorescent probes.   

Elicit/Engage/ Evaluate:  Ask students to think what causes fluorescence in terms of excitation and emission wavelength. The 

instructors should provide background information and explain the physics behind wavelength and color of fluorescent probes.  

20-25 Fluorescent Probes 

Cellular Scale  

 

Mini-Lecture  

Fluorescence can be incorporated 

into endothelial cells 

 

Students will understand that there are different 

colored fluorescent probes or stains used in 

molecular imaging that aid understanding of 

biological structure.  

25-35 Endothelial Cell  

 
Mini-Demonstration  

Use NIH Image J to quantify 

intensity of DAPI stained nucleus 

of endothelial cell  

Students will understand that molecular imaging 

can be quantified 

Students will be able to apply knowledge of NIH 

Image J  

Elicit/Engage/ Evaluate:  Ask students to think how different structures in a cell are tagged with different fluorescent probes. 

Instructor should show structure of fluorescent probes and images of various cells with attached probes.    

35-45 Human Embryonic Stem 

Cell  
Activity: 

Answer questions about 

differentiation observed in 

molecular images of human 

embryonic stem cells tagged with 

eGFP. 

  

  

 

Students will understand that molecular images 

of human embryonic stem cells tagged with 

eGFP provide ways of knowing biological 

function, differentiation 

 

Students understand that human embryonic stem 

cell information can advance tissue re-

engineering and contribute to regenerative 

medicine and  the NIH Roadmap initiatives.  

Evaluate/ Extend: The instructor should show the different types of human embryonic stem cell differentiation. Ask students to 

observe the molecular images of stem cells tagged with eGFP to determine the type of differentiation observed. This activity 

addresses the misconception that molecular images relate structure not function. Ask students to think how information from these 

molecular images can advance tissue reengineering and improve regenerative medicine.     

45-55 Molecular images 

 
Discussion 

Molecular imaging  

Fluorescent probe, eGFP 

Students will understand that molecular images 

tagged with fluorescent probes provide ways of 

knowing biological structure and function 

Engage/Explore: Ask students to think about what other cells can be tagged and what other biological functions can be studied.  

Day 3 

 
                                             Medical Imaging 

0-10 X ray Minilecture  

 

Students will understand that X-ray images 

increase our knowledge of biology for example 

the structure of DNA.  
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Students will understand that X ray images are 

used in diagnosis and crystallography.  

Elicit/Engage/ Evaluate:  Review biological and imaging scales. Ask students to think about their own exposure to X rays. This 

minilecture addresses the misconception that images do not advance science and medicine. The instructor should show the 

crystallographic image of DNA that was used to figure out its structure.    

10-20 CT 

 
Minilecture: 

CT  

Case Study: Phineas Gage 

Images and Model of Skull 

Students will understand the importance of 

relating biological scale with the imaging scale 

of the CT scanner when producing medical 

images of Gage’s skull. 

 

Students will understand that medical images of 

Phineas Gage’s skull brought to light the 

relationship between brain structure and 

function.  

Elict/Engage/ Evaluate: Instructor should tell Phineas Gage’s story and show CT images of Gage’s skull. Ask students to think 

about what brain structures were damaged and how that affected Gage’s personality. This addresses the misconception that images 

do not advance science and medicine.   

20-25 Survey Activity: Answer survey 

questions about Gage’s skull 

images and model. 

 

  

Students will develop their evaluation skill by 

considering the visual information obtained from 

the 2D image, the 3D virtual reality image, and 

the stereolithographic skull model of Gage 

Elict/Engage/ Evaluate: Instructor should show 2D images and 3D virtual reality images of Gage’s skull.  Instructor should 

explain how a stereolithographic model of Gage’s skull was made from CT images and should pass the skull model around class 

for evaluation. This addresses the misconception that images do not advance science and medicine.   

25-33 MRI  

 
Minilecture  

MRI 

fMRI  

Images and Model of Brain 

Students will understand the importance of 

relating biological scale with the imaging scale 

of the MRI when producing medical images of a 

brain. 

 

Students will understand that fMRI images of the 

brain show a relationship between brain structure 

and function.  

33-37 Survey Activity:  

Answer survey questions about 

brain images and model. 

  

 

Answer survey questions about 

images and model in general 

Students will develop their evaluation skill by 

considering the visual information obtained from 

the 2D image, the 3D virtual reality image, and 

the stereolithographic brain model  

 

Students will develop their evaluation skill by 

considering the informativeness and usefulness 

obtained from the 2D image, the 3D virtual 

reality image, and the stereolithographic models. 

Elict/Engage/ Evaluate: Instructor should show 2D images and 3D virtual reality images of a brain. The instructor should explain 

how a stereolithographic model of the brain was made from MRI images and should pass the brain model around class for 

evaluation 

37-42 PET Minilecture 

PET 

Radioactive Marker:   

18-Fluorodeoxyglucose (18FDG)  

 

Students will understand the importance of 

producing nuclear medical images with 18FDG. 

a radioactive marker, which traces the location of 

high glucose metabolism as occurs in a tumor. 

 

Students will understand that nuclear medical 

images can advance nuclear medicine that 

contributes to the NIH Roadmap initiatives. 

42-52 PET  

 
Activity: 

Answer questions using PET 

brain images with 18 FDG marker  

 

Students will understand that the PET imaging 

process uses radioactive contrast and provides 

ways of knowing biological structure and 

function 

 

 

 

Evaluate/Engage/Elaborate: Ask students to think about the importance of using radioactive contrast material in PET images. 
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Instructors should show the chemical structure of the radioactive marker. This addresses the concept that imaging is a 

multidisciplinary science.  

52-54 Web Resources Minilecture:  Students will understand that the internet has 

imaging resources.  

Students will be able to develop their computer 

skills.  

54-55 Course Summary Course Summary Students will understand that imaging is a 

quantitative tool which provides ways of 

knowing biology, and advances nanomedicine, 

regenerative medicine, and nuclear medicine 

which contribute to the goals of the 

 NIH Roadmap.   

Online Assessment Post Quiz Online Students and instructors will be able to assess 

learning gains 

 

 

VI. TEACHING MATERIALS 

 A. Schedule 

These materials can be used in three, 50-minute class periods. 

 B. Notes/ Supplementary Materials 

  Teaching slides are attached. 

C. Surveys 
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Survey: Pre-Quiz    
To what extent do you have knowledge in the following areas: 

 

 Not at all A little Somewhat A lot A great deal 

Nanoimaging      

Molecular Imaging      

System Level Imaging      

Imaging as a quantitative tool      

Imaging as a non-invasive tool      

Biological Scale      

Biological Imaging Tools      

Using Imaging Software      

Imaging Internet Resources      

 

 

How much skill with imaging do you have in: 

 Not at all A little Somewhat A lot A great deal 

Developing Hypotheses from Images      

Interpreting Imaging Studies      

Recognizing Biological Scale in Images      

Quantifying Images      

 

1) Define biological scale and its relation to imaging?  

 

 

 

 

 

 

 

 

2) Identify 3 imaging techniques and describe how they are used to ask and answer questions about biological 

processes or disease. Do not use X-rays as an example. 

 

 

 

 

 

 

 

 

 

3) Chest X rays of a patient taken at different times show (A) 

healthy lungs and (B) lungs with inflamed tissue due to pneumonia. 

Describe the steps you would take to quantify differences between 

images A and B? 

 

 

 

 

 

 

 

Right  Left 

 

 
http://www.answers.com/topic/ 

pneumonia-x-ray-jpg-1 
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Survey: Medical Imaging  
 

Student ID __________________________________ 

 

Rate the quality of visual information contained in the following models. 

Model 

 

Inferior Similar/ 

Equivalent 

Superior  

(similar information more 

rapidly assimilated) 

Superior 

(additional information 

provided) 

Brain Cortical Surface 

2D                      Baseline 

VRML      

Stereolithograph     

  

Phineas Gage Skull Injury 

2D                      Baseline 

VRML      

Stereolithograph     

 

 

 

 

Evaluate the usefulness of different model types for understanding biology:     

   

 A little Somewhat A lot A great deal 

2D     

VRML      

Stereolithograph     

 

 

                        3.  Survey: Post-Quiz  

 
Student ID 

 

Do you own a laptop?       Yes                 No 

 

Did you use NIH Image J for class on your own laptop?      Yes                 No 

 

If yes, to what extent do you agree with the following statement: 
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 Not at all A little Somewhat A lot A great deal 

Image J was easy to get working on my laptop. 

 

     

 

Please grade Dan Kelley, the instructor for the imaging unit: 

 

 A    

 

B            C                        D F 

Instructor’s ability to stimulate interest       

Instructor’s interest for the subject       

Instructor’s ability to explain concepts clearly       

Instructor’s effectiveness       

Instructor’s enthusiasm for the subject       

Overall grade      

 

 

To what extent did your knowledge increase in the following areas as a result of your work in the imaging unit: 

 

 Not at all A little Somewhat A lot A great deal 

Nanoimaging      

Molecular Imaging      

System Level Imaging      

Imaging as a quantitative tool      

Imaging as a non-invasive tool      

Biological Scale      

Biological Imaging Tools      

Using Imaging Software      

Imaging Internet Resources      

NIH Roadmap      

 

 

How much did the following help you learn about imaging: 

 Not at all A little Somewhat A lot A great deal 

Mini Lectures      

Group Activities      

Image J      

Printed 3D models      

Virtual 3D models      

Internet Resources      

The Topics Covered      

Overall Course      

 

To what extent did the imaging unit emphasize that: 

 Not at 

all 

A 

little 

Somewhat A 

lot 

A great 

deal 

Imaging impacts society      

Imaging provides a way of knowing biology at different scales      

Imaging is an important part of the NIH Roadmap      

 

How much has this unit added to your imaging skills in: 

 Not at all A little Somewhat A lot A great deal 

Developing Hypotheses from Images      

Interpreting Imaging Studies      

Recognizing Biological Scale in Images      

Quantifying Images      
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To what extent did you make improvements in the following as a result of your work in this imaging unit: 

 

 Not at 

all 

A 

little 

Somewhat A 

lot 

A great 

deal 

Enthusiasm for this field      

Interest in pursuing imaging courses      

Importance of this field      

Confidence in your ability to take part in this field      

Understanding that imaging techniques impact society      

Understanding that imaging offers new insights into biological 

structure and function 

     

Understanding that imaging impacts medicine      

Understanding that future patients will benefit from ongoing 

imaging research 

     

 

 

 

 

 

 

Please answer the extent to which you agree with these statements: 

 

 Not at 

all 

A 

little 

Somewhat A 

lot 

A great 

deal 

Imaging should be an integral part of biology education      

Imaging is an integrated, multidisciplinary field      

The overall content of the course was appropriate      

Image J contributed positively to this course      

After taking this course, I would like to pursue an imaging 

career 

     

Future imaging courses should use the same format as this 

course 

     

 

 

1) Define biological scale and its relation to imaging?  

 

 

2) Identify 3 imaging techniques and describe how they are used to ask and answer questions about biological 

processes or disease. Do NOT use X-rays as an example. 

 

 

 

 

3) These chest X rays of a patient taken at different times show (A) healthy lungs and (B) lungs with inflamed tissue 

due to pneumonia. The letters A and B are written on the patient's anatomical right side. Describe the steps you would 

take to quantify differences between images A and B? 
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http://www.answers.com/topic/pneumonia-x-ray-jpg-1 

 

 

 

 

 

 

4) Comments about the imaging unit? 
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Classroom Resources for Ways of Knowing Biology 2007:       

Imaging 

 
NIH Videocast 

Zerhouni/Lipincott-Scwartz 

http://videocast.nih.gov/launch.asp?13093 

  

Electron microscope 

http://www.mos.org/sln/sem/seminfo.html 

  

NanoBucky 

http://hamers.chem.wisc.edu/research/nanofibers/index2.htm 

  

 
  

  

Image J 

http://rsb.info.nih.gov/ij/applets.html 

  

ImageJ with JAVA  

http://rsb.info.nih.gov/ij/ImageJ.jnlp 

  

Biofluorescence:GFP 

http://www.loci.wisc.edu/optical/probes.html 

http://www.conncoll.edu/ccacad/zimmer/GFP-ww/GFP-1.htm 

  

Teaching GFP: 

http://www.wisc.edu/wistep/teach/pdf/explore_gfp/text.pdf 

http://www.wisc.edu/wistep/teach/pdf/explore_gfp/append.pdf 

  

Alba Activity 

https://mywebspace.wisc.edu/djkelley/web/Alba.doc 

  

Alba  

http://www.ekac.org/gfpbunny.html#gfpbunnyanchor 

 

 

Eduardo Kac and Alba, the 

fluorescent bunny. 

Alba, the GFP Bunny 
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Photo: Chrystelle Fontaine 

 
 

Photo: Chrystelle Fontaine 

 

  

Confocal imaging  

http://loci.wisc.edu/confocal/confocal.html 

  

Fluorescence Imaging 

http://www.microscopyu.com/articles/fluorescence/index.html 

  

Wisconsin Embryonic Stem Cell Diagram: 

 http://www.news.wisc.edu/packages/stemcells/illustration.html 

  

 
  

  

Discussion Paper: 

Zwaka TP, Thomson JA. 

Differentiation of human embryonic stem cells occurs through symmetric cell division.Stem Cells. 

2005 Feb;23(2):146-9.  

http://stemcells.alphamedpress.org/cgi/content/full/23/2/146 

  

E. Explore Websites 
Brainmaps 

http://brainmaps.org/ 

  

Visible Human Project  

 http://www.nlm.nih.gov/research/visible/visible_human.html 

  

Anatquest Viewer 

http://anatline.nlm.nih.gov/index.html 

  

National Museum of Health and Medicine Brain Collections 

-Video Overview: 

http://nmhm.washingtondc.museum/collections/neuro/NMHM-PBS.mpg 

-UW-Madison Wally Welker Comparative Anatomy Collection,   
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http://brainmuseum.org/ 

-The Navigable Atlas of the Human Brain using the Yakovlev-Haleem Collection 

http://www.msu.edu/~brains/humanatlas/ 

  

NIH Videocast  

Demystifying Medicine - Imaging: A New Frontier for Organs and Cells  

Elias Zerhouni (OD) and Jennifer Lippincott-Schwartz (NICHD)  

Electronic Links: http://videocast.nih.gov/launch.asp?13093  

  

The Human Brain: Cerebrum, Lobes and Cortical Regions 

by Ethan Blanchette (Anatomy and advanced biology, Harvard) 

http://outreach.mcb.harvard.edu/teachers/Summer05/EthanBlanchette/Human_brain.ppt 

  

X ray, MRI, CT, PET 

http://www.mos.org/doc/1921 

  

Bone Density 

http://science.exeter.edu/jekstrom/LABS/LABS.html 

  

Phineas Gage 

http://www.neurosurgery.org/cybermuseum/pre20th/crowbar/crowbar.html 

http://content.nejm.org/cgi/content/full/351/23/e21/DC1 

  

PET  

Handouts: http://science.education.nih.gov/supplements/nih2/addiction/guide/pdfs/master1.1-

1.7.pdf 

Video: http://science.education.nih.gov/supplements/nih2/addiction/activities/lesson1_pet.htm 

  

Contrast agents: NIH MICAD Database 

http://www.ncbi.nlm.nih.gov/books/bookres.fcgi/micad/home.html 

  

Understanding Dimensions in Biology 

http://www.loci.wisc.edu/cambio/bio.html 

 

F. Background Reading 
Massoud TF, Gambhir SS.  

Molecular imaging in living subjects: seeing fundamental biological processes in a new light. 

Genes Dev. 2003 Mar 1;17(5):545-80. Review. No abstract available.  

PMID: 12629038 

http://www.genesdev.org/cgi/content/full/17/5/545 

  

Cassidy PJ, Radda GK. 

Molecular imaging perspectives. 

J R Soc Interface. 2005 Jun 22;2(3):133-44. Review.  

PMID: 16849174 

http://www.journals.royalsoc.ac.uk/media/52lwqlyrwmndhul3hjf3/contributions/g/h/y/g/ghyg583q9

4pa9bay_html/fulltext.html 

  

From Bones to Atoms: Imaging Nature across Dimensions 

http://www.mih.unibas.ch/Booklet/Booklet96/Booklet96.html 

  

Science Web Extra: Biological Imaging 4 April 2003  Vol 300,  

Issue 5616, Pages 1-196 

http://www.sciencemag.org/feature/data/bioimaging/index.dtl 

  

Nature Cell Biology Web Focus: Imaging in Cell Biology 

http://www.nature.com/focus/cellbioimaging/index.html 

 

G. Additional Resources 
Wisconsin Histology Images 

http://histology.med.wisc.edu/histo/uw/htm/ttoc.htm 
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Wisconsin Gross Anatomy Images 

http://www.anatomy.wisc.edu/courses/gross/ 

  

Wisconsin Radiology Tutor 

http://www.radiology.wisc.edu/education/forStudents/neuroradiology/NeuroRad/TOC.htm 

  

Wisconsin Xenopus Neurulation Video 

http://worms.zoology.wisc.edu/frogs/neuru/neuru_xen_timel.html 

  

Wisconsin Electron Micrograph Library: DNA, DNA-Protein complexes & Virus 

http://www.biochem.wisc.edu/inman/empics/ 

  

Wisconsin Stem Cell Images 

http://www.news.wisc.edu/packages/stemcells/labphotos.html 

  

Wisconsin Laboratory for Optical and Computational Instrumentation (LOCI) 

http://www.loci.wisc.edu 

  

Wisconsin W.M. Keck Laboratory for Biological Imaging 

http://www.keck.bioimaging.wisc.edu/ 

  

Wisconsin Virus World 

http://rhino.bocklabs.wisc.edu/virusworld 

  

Wisconsin Waisman Laboratory for Brain Imaging and Behavior 

http://brainimaging.waisman.wisc.edu/ 

  

Wisconsin Virtual Foliage Homepage 

http://botit.botany.wisc.edu/ 

  

Wisconsin Microscopy 

http://www.microscopy.wisc.edu/ 

  

Wisconsin Biological & Biomaterials Preparation, Imaging, and Characterization Facility 

http://www.ansci.wisc.edu/facstaff/Faculty/pages/albrecht/albrecht_web/Programs/microscopy/ho

me.html 

  

Wisconsin Microbial World (Ken Todar) 

http://www.bact.wisc.edu/themicrobialworld/homepage.html 

  

Society for Neuroscience Database for Images and Atlases 

http://ndg.sfn.org/ 

  

Virtual Microscope 

http://virtual.itg.uiuc.edu/ 

  

NASA Remote Sensing Tutorial: Medical Imaging 

http://rst.gsfc.nasa.gov/Intro/Part2_26b.html 

  

National Institute of Biomedical Imaging and Bioengineering (NBIB) 

http://www.nibib1.nih.gov/HealthEdu/ScienceEdu/Resources/Parents 

  

NBIB Picture and Video Gallery 

http://www.nibib.nih.gov/publicPage.cfm?section=gallery&action=view 

  

Image & Video Library of The American Society for Cell Biology (ASCB) 

http://cellimages.ascb.org/ 

  

Science Museum: Imaging the Living Brain 

http://www.sciencemuseum.org.uk/exhibitions/brain/178.asp 
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Microbiology Video Library 

http://www-micro.msb.le.ac.uk/video/ 
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VII. STUDENT MATERIALS 

 

A. Day 1-Nanoimaging 
 

NanoBucky  

 

Learning goals: 

1) Understand nanoscale imaging. 

2) Understand how imaging provides scientists with ways of knowing biological processes. 

3) Recognize that imaging is a quantitative tool in biology by observing, measuring, and interpreting biological images 

 

Students meet the learning goals when they understand the relationship between biological scale and imaging scale, 

when they can answer questions  about  the way images provide ways of knowing biology,  and when they can quantify 

images of Nanobucky with NIH Image J.   

 

Instructions: 

In small groups of 4 to 6, students will complete the following activity. Use the questions to guide you through this 

activity. 

 

Duration: 

This activity should take 30 minutes. 

 

Credits: 

This activity was developed from online resources: 

 

1) Patterned Nanofibers: The making of "NanoBucky" 

Sarah Baker, Kiu-Yuen Tse, Jeremy Streifer, Matthew Marcus, and Prof. Robert Hamers 

Hamers Research Group,UW-Madison 

http://hamers.chem.wisc.edu/research/nanofibers/index2.htm 

 

 

2) NIH Image J 

http://rsb.info.nih.gov/ij 

 

3) Image J Documentation Wiki 

http://imagejdocu.tudor.lu/imagej-documentation-wiki 

 

 

Nanobucky is a fun example of the ability to control the synthesis of nanoscale materials such as carbon nanofibers. 

Nanobucky is made entirely from tiny "hairs" of carbon nanofibers.  

 Nanobucky 
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The carbon nanofibers that make up Bucky are of great interest for practical applications such as chemical and 

biological sensing and as high surface-area materials for use in applications such as energy storage. So, while 

NanoBucky is fun, there is some serious science behind making structures such as this. 

 

Students’ goal is to quantify the height and image intensity of Nanobucky using NIH Image J Software. 

 
Student Directions:  

Start Image J directly or with the JAVA servlet http://rsb.info.nih.gov/ij/ImageJ.jnlp 

 

Load the image File>Open>nanobucky1.gif 

 

Set the scale of your measurements 

 Click the straight line tool on the toolbar and place a line over the image scale bar. 

  Image> Zoom In may be helpful 

Click Analyze>Set Scale 

Use this Set Scale dialog to define the spatial scale of the active image so measurement results can 

be presented in calibrated units, such as millimeters. 

Enter the known distance and unit of measurement, then click OK. ImageJ will have automatically 
filled in the Distance in Pixels field based on the length of the line selection. 

Set Distance in Pixels to zero to revert to pixel measurements. 

Setting Pixel Aspect Ratio to a value other than 1.0 enables support for different horizontal and 

vertical spatial scales, for example 100 pixels/cm horizontally and 95 pixels/cm vertically. . In this 

exercise leave a number 1 in the dialog box. 

When Global is checked, the scale defined in this dialog is used for all images instead of just the 
active image. Check the global box 

Next Set Measurements by clicking Analyze> Set Measurements 

Use this dialog box to specify which measurements are recorded by Analyze/Measure in the next step 

Make sure the following options are selected. 
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Area - Area of selection in square pixels. Area is in calibrated units, such as square millimeters, if 
Analyze>Set Scale was used to spatially calibrate the image. 

Mean Gray Value - Average gray value within the selection. This is the sum of the gray values of all the 

pixels in the selection divided by the number of pixels. Reported in calibrated units (e.g., optical density) if 

Analyze>Calibrate  was used to calibrate the image. For RGB images, the mean is calculated by converting 

each pixel to grayscale using the formula gray=0.299*red+0.587*green+0.114*blue if "Weighted RGB 

Conversion" is checked in Edit>Options>Conversions or the formula gray=(red+green+blue)/3 if not 
checked. 

Min & Max Gray Value - Minimum and maximum gray values within the selection. 

Feret's Diameter - The longest distance between any two points along the selection boundary. Also known 
as the caliper length.  

Integrated Density - The sum of the values of the pixels in the image or selection. This is equivalent to the 

product of Area and Mean Gray Value.  

Decimal Places - This is the number of digits to the right of the decimal point in real numbers displayed in 

the results table and in histogram windows.  Set this to 3. 

Draw a Region of Interest Measurement 

Draw a vertical line from NanoBucky’s head to toe. Try to select the maximum distance you can find. 

Analyze your Measurement 

 Click Analyze>Measure 

Based on the selection type, the Measure command calculates and displays either area statistics, 

line lengths and angles, or point coordinates. 

Area statistics are calculated if there is no selection or if a subregion of the image has been selected 

using one of the first four (area selection) tools in the tool bar. Calculates line length and angle if a 
line selection has been created using one of the three line selection tools. 

With line selections, the following parameters can be recorded: length, angle (straight lines only), 

mean, standard deviation, mode, min, max and bounding rectangle (v1.34l or later). The mean, 
standard deviation, etc. are calculated from the values of the pixels along the line. 

 

1) Record the line results here: 

 

 

Students: Repeat the measurement and analysis process but now with an Ellipse that just encircles NanoBucky 

2) Record ellipse results here: 
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3) How tall is NanoBucky? 

 

4) What is the mean grey value based on your ellipse measurements? 
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Day 2 - System And Cellular Molecular Imaging Using EGFP 

1. Alba: The EGFP Bunny 

 
Learning objectives: 

1) Understand macroscale molecular imaging techniques. 

2) Understand how imaging provides scientists with ways of knowing biological processes. 

3) Recognize that imaging is a quantitative tool in biology by observing, measuring, and interpreting biological images 

 

Instructions: 

In small groups of 4 to 6, complete the following activity. Use the questions to guide you through this activity. 

Duration: 

This activity should take 10 –15 minutes. 

 

Credits: 

This activity was developed from online resources: 

 

1) USING THE GREEN FLOURESCENT PROTEIN TO TEACH MOLECULAR LITERACY: THE FLOW OF 

GENETIC INFORMATION AT THE MOLECULAR LEVEL; Michael H. Patrick, Ph.D and Tim Herman, Ph.D.; 

Wisconsin Teacher Enhancement Program, UW-Madison; Center for BioMolecular Modeling, Milwaukee School of 

Engineering 

http://www.wisc.edu/wistep/teach/pdf/explore_gfp/text.pdf 

 

2) GFP Bunny (2000), text by Eduardo Kac. 

http://www.ekac.org/gfpbunny.html#gfpbunnyanchor 

 

 

 

Green fluorescent protein was identified in 1971 as the protein responsible for the green fluorescence of the Pacific 

Northwest jellyfish, Aequoria Victoria. The protein was purified and the structure determined in 1996. Around the 

same time, the gene encoding this protein was cloned and introduced into a variety of other cells, from bacteria to 

human cells.” "Alba", a fluorescent bunny, is an albino (white) rabbit with no skin pigment. Alba was engineered using 

EGFP, an enhanced GFP that provides greater intensity fluorescence than GFP. Under different lighting conditions, 

Alba appears to change colors. 

 

ALBA 

 

 
 

Photo: Chrystelle Fontaine 

 

Use the information below to answer the following  questions: 

 

Based on the photos above what color is Alba?  
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Based on the emission spectra for EGFP below, what color light does EGFP emit? 

 

 

 

Based on the excitation spectra for EGFP below, what wavelength of light can excite EGFP? 

 

 

 

What color light must shine on Alba in order for Alba to glow? What color should Alba glow? 

 

 

 

Does Alba glow in the dark? If not, why not? When will Alba glow? Does Alba glow all the time? 

 

 
 

http://jcs.biologists.org/cgi/content/full/114/5/837 

Journal of Cell Science 114, 837-838 (2001) 

 

 

 

 

 

Color  

Wavelength (nm) 

 

Frequency (THz) 

 

 

Red 780 - 622  384 - 482 

Orange 622 - 597 482 - 503 

Yellow 597 - 577 503 - 520 

Green 577 - 492 520 - 610 

Blue 492 - 455 610 - 659 

Violet 455 - 390 659 - 769 

1 terahertz (THz) 

= 103 GHz 

= 106 MHz 

= 1012 Hz 

 

1 nm 

= 10-3 um 

= 10-6 mm 

= 10-9 m 

    

The white  light is a mixture of the colors of the visible spectra.  

http://www.usbyte.com/common/approximate_wavelength.htm 
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ALBA

 
 

Photo: Chrystelle Fontaine 
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B. Day 2 - System And Cellular Molecular Imaging Using EGFP 

2.  EGFP in Embryonic Stem Cells 
 

Learning objectives: 

1) Understand microscale molecular imaging techniques. 

2) Understand how imaging provides scientists with ways of knowing biological processes. 

3) Recognize that imaging is a quantitative tool in biology by observing, measuring, and interpreting biological images 

4) Demonstrate proficiency with the analyze tool in NIH Image J software by quantifying biological images.  

5) Understand the language of biological imaging. 

 

Instructions: 

In small groups of 4 to 6, complete the following activity. Use the questions to guide you through this activity. 

Duration: 

This activity should take 10 –15 minutes. 

Credits: 

This activity was developed from online resources: 

 

1) Zwaka TP, Thomson JA.  

Differentiation of human embryonic stem cells occurs through symmetric cell division. 

Stem Cells. 2005 Feb;23(2):146-9. 

PMID: 15671139 

http://stemcells.alphamedpress.org/cgi/content/full/23/2/146 

 

 

 

Pluripotent ES cells can divide and differentiate into any cell type. Oct4 is a protein solely expressed in pluripotent 

cells. By tagging the protein with EGFP, this protein becomes a marker for pluripotency and can help determine the 

mechanism by which pluripotent cells divide and differentiate. Retinoic acid (RA) induces pluripotent cells to 

differentiate. 

 

 

 
 

 

“We tracked the differentiation state of human embryonic stem cells using an Oct4-eGFP knock-in cell line. Oct4 is a 

central regulator of pluripotency. It is expressed exclusively in the pluripotent cells of the embryo. We used time-lapse 

videomicroscopy over 5 days to track phase-contrast images.  EGFP expression levels…are an indicator of Oct4 

expression. Figure 1A depicts an undifferentiated, Oct4+, human embryonic stem cell (arrow) undergoing a cell 

division. Both daughter cells show synchronous down regulation of eGFP, and therefore Oct4. Differentiation was also 

indicated by the change in morphology observed in the corresponding phase-contrast images. In total, we tracked… 60 

individual cells for 5 days under each of the four conditions (Fig. 1B). To determine eGFP fluorescence, the shape of 

individual cells was determined and a region of interest (ROI) was defined. ROIs were transferred into the acquired 

fluorescence image…” 
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Figure 1. Human embryonic stem cells differentiate symmetrically. (A): Extracts from time-lapse analysis showing 

differentiation of one human embryonic stem cell colony after RA treatment. A representative cell and its two daughter 

cells are marked with arrows; green shows eGFP, reflecting the internal level of Oct4 in individual cells. Following cell 

division, both daughter cells down regulate eGFP and, therefore, Oct4 in the same way. (B): Mean eGFP fluorescence 

in one human embryonic stem cell after induction of differentiation with RA. The eGFP signal has been followed over 

time. The time point of cell division is marked. Three sequential images were used to determine eGFP fluorescence 

intensity for individual cells. Error bar, standard error of mean. Abbreviations: eGFP, enhanced green fluorescent 

protein; ES, embryonic stem; RA, retinoic acid. 

 

 

What are the emission and excitation peaks for EGFP tagged Human Embryonic Stem Cells?  

 

 

 

 

What is the EGFP being used to monitor?  

 

 

 

 

Why was time lapse microscopy used?  

 

 

 

 

How was the graph in panel B made and what does it show?  

 

 

 

 

How do the scientists know that Oct4 expression is reduced in differentiated cells? 
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C. DAY 3 - Positron Emission Tomography (PET) Imaging 

                     Using 18-Fluorodeoxyglucose (
18
FDG) 

 

3D stereolithographic brain bodel and Phineas Gage skull model are available from David Nelson or the UW-Madison 

Biotechnology Center. This is to be used in conjunction with the medical imaging survey. 

 

 

Learning goals: 

1) Know that PET is an interdisciplinary imaging modality 

2) Know that PET helps us understand the relationships between specific areas of the  

     brain and what function they serve 

3) Know that FDG PET measures metabolic activity  

4) Know that PET uses radioactive compounds 

5) Know that PET has clinical applications 

6) Know imaging vocabulary: PET and FDG 

 

The learning goals, which were addressed in PowerPoint presentations and online resources, need to be understood in 

order to  answer the questions in this activity.  

 

Instructions:  

In small groups of 4 to 6, complete the following activity. Use the questions to guide you through this activity. 

 

Duration:  

This activity should take 10 –15 minutes. 

 

Credits: 

This activity was developed from online resources: 

 

1) NIH Office of Science Education and the National Institute on Drug Abuse 

NIH Curriculum Supplement Series on “The Brain: Understanding Neurobiology Through the Study of Addiction” 

http://science.education.nih.gov/supplements/nih2/addiction/default.htm 

 

2) UW-Madison Cyclotron/ Positron Emission Tomography Research Center  

http://www.medsch.wisc.edu 

 

 

Interpreting PET Images 

 

This can be obtained by download from the NIH Office of Science Education and the National Institute on Drug Abuse 

NIH Curriculum Supplement Series on “The Brain: Understanding Neurobiology Through the Study of Addiction”  

http://science.education.nih.gov/supplements/nih2/addiction/default.htm  

 

The file containing the activity is located at: 

http://science.education.nih.gov/supplements/nih2/addiction/guide/pdfs/master1.1-1.7.pdf 

 

 

 

 

 

Clinical Case Application 

 

Below are PET images collected at the University of Wisconsin-Madison Cyclotron/ Positron Emission Tomography 

Research Center (http://www.medsch.wisc.edu). Two patients were scanned using FDG while at rest. One of the 

patients is thought to have a tumor. On the images, white indicates greater glucose metabolism. 

 

 

At approximately what level was each slice taken (a,b,c, or d)? 

 

Patient 1: 

 

Patient 2: 
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By comparing to the images in Set 1, circle which patient has a tumor? 

 

Patient 1            OR         Patient 2 

 

 

  

 

 

 

  Patient 1 Patient 2 

  

http://www.medsch.wisc.edu/cycl/ 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 




